
Škoda Fabia už

od 14 480 €

Letné cenové zvýhodnenie

až 1 600 €

Cenník Škoda Fabia



Zvýhodnenie* -1 600 -1 600 -
Akciová cena ** 14 480 15 040 -

Zvýhodnenie* -1 600 -1 600 -1 600
Akciová cena ** 15 220 15 750 18 420

Zvýhodnenie* -1 600 -1 600 -1 600
Akciová cena ** 15 620 16 150 18 900

Zvýhodnenie* - -1 600 -1 600
Akciová cena ** - 17 690 20 440

Zvýhodnenie* - -1 600 -1 600
Akciová cena ** - 19 380 21 980

Všetky informácie o aute
Modelová stránka

Vyskladajte si auto podľa seba
Online konfigurátor

* Letné cenové zvýhodnenie je platné do 31.08.2025. Bližšie informácie o uplatnení a podmienkach akcie získate u participujúcich dílerov Škoda.
** Najnižšie ceny príslušných motorových vozidiel za posledných 30 dní vám poskytujeme v zmysle zákona č. 108/2024 Z.z. o ochrane spotrebiteľa
a sú dostupné na internetovej stránke www.skoda.sk/ceny.

Fabia
Motor

.
Palivo

.
Prevodovka

.
Pohon

.
Cena (s DPH)

.
Essence

.
Selection

.
Monte Carlo

.

1.0 MPI 59 kW (80 k)
.

Benzín
.

5° MP
.

predný
. Základná cena . 16 080 . 16 640 . - .

1.0 TSI 70 kW (95 k)
.

Benzín
.

5° MP
.

predný
. Základná cena . 16 820 . 17 350 . 20 020 .

1.0 TSI 85 kW (116 k)
.

Benzín
.

6° MP
.

predný
. Základná cena . 17 220 . 17 750 . 20 500 .

1.0 TSI 85 kW (116 k)
.

Benzín
.

7° AP DSG
.

predný
. Základná cena . - . 19 290 . 22 040 .

1.5 TSI 110 kW (150 k)
.

Benzín
.

7° AP DSG
.

predný
. Základná cena . - . 20 980 . 23 580 .
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Prečo práve Fabia?

Neprehliadnuteľná
Škoda Fabia ponúka už v štandardnej výbave predné a zadné
svetlomety s LED technológiou. Na prianie môžete získať tiež Full
LED predné svetlomety

Bezpečná
O bezpečnosť posádky vozidla sa postará až 9 airbagov a s balíkmi
Assisted Drive získate na cestách ďalšiu úroveň bezpečnosti a
komfortu.

Priestranná
Fabia disponuje veľkorysým objemom batožinového priestoru, ktorý
sa s hodnotou 380 l zaraďuje nad priemer vo svojej triede. Zaručene
tiež poteší medzigeneračný nárast priestoru pre cestujúcich vzadu, a
to pozdĺžne aj na šírku.

Monte Carlo
Najvyšší výbavový stupeň Monte Carlo prináša exkluzívne dizajnové
prvky v interiéri a exteriéri. Vďaka príplatkovému športovému
podvozku a výkonným benzínovým motorom si užijete s vozidlom
zábavnú a dynamickú jazdu.

Vyberte si svoj interiér

Loft Lodge

Suite Dynamic
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Interiér Studio

Oceľové disky kolies 5,5J x 15" s krytmi Callisto (185/65 R15)

Zadné kotúčové brzdy (len pre 1.0 TSI 85kW )

ESC vrátane ABS, MSR, ASR, EDS, HBA, XDS

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

Front Assist – výstraha pred kolíziou a podpora núdzového brzdenia
a Pedestrian Monitor (ochrana chodcov)

ISOFIX a Toptether pre sedadlo spolujazdca

3. hlavová opierka vzadu

Lane Assist – asistent udržiavania v jazdnom pruhu

Driver Alert - asistent rozpoznania únavy

Easy Light Assist – svetelný senzor

Kontrola tlaku v pneumatikách

LED hlavné svetlomety + LED denné svietenie

Predné hmlové svetlomety

Centrálne zamykanie s diaľkovým ovládaním (2 sklopné kľúče)

Infotainment Škoda s 8" dotykovým displejom

4 reproduktory vpredu

DAB – digitálny rádiopríjem

Bluetooth

8" virtuálny kokpit

Čítanie dopravných značiek

2-ramenný PUR volant

Parkovacie senzory vzadu

Elektricky nastaviteľné a vyhrievané vonkajšie spätné zrkadlá, lakované
vo farbe karosérie

Elektrické ovládanie okien vpredu

Obmedzovač rýchlosti

Manuálna klimatizácia

Funkčný paket: 3 stropné madlá (zadné s háčikmi), slnečné clony
s Make-up zrkadlom na strane vodiča a spolujazdca, schránka
na okuliare, lampičky na čítanie vpredu a vzadu

Zadné sedadlá nedelené, zadné operadlá delené a sklopné v pomere
60:40

Tyre Fit – súprava na opravu pneumatík

eCall

Proaktívny servis na 10 rokov

Predĺžená záruka na 5 rokov/100 000 km
(Platí tá z podmienok, ktorá nastane skôr, prvé 2 roky bez
obmedzenia počtu kilometrov)

Premenlivý servisný interval s výmenou oleja až 30 000 km alebo
každé 2 roky

Škoda – Doživotná Garancia Mobility Premium
Poskytuje pomoc servisným vozidlom na mieste poruchy (porucha
na vozidle, chýbajúce PHM, defekt pneumatiky, zabuchnuté/stratené
kľúče, vybitá batéria, zámena paliva), odtiahnutie vozidla, prípadne
služby – náhradnú dopravu, požičanie náhradného vozidla, ubytovanie
pre posádku a i.

Interiér Loft

Poťah prístrojovej dosky Látka Kota Grey

Disky Proxima z ľahkej zliatiny 6J × 16" – strieborné (iba
pre 1.5 TSI 110 kW)

Zadné kotúčové brzdy (len pre 1.0 TSI 85 kW a 1.5 TSI 110 kW)

Full LED zadné svetlá

Asistent rozjazdu do kopca

Easy Start - centrálne zamykanie s diaľkovým ovládaním a štartovaním
tlačidlom, bez Safe systému

2 reproduktory vzadu

Bezdrôtový Smartlink

2-ramenný kožený multifunkčný volant

Výškovo nastaviteľné sedadlo vodiča

Tempomat s obmedzovačom rýchlosti

Úložné vrecká na zadnej strane operadiel predných sedadiel

Dáždnik vo výplni dverí vodiča

Chrómované ovládače prívodu vzduchu a rámčeky prívodu vzduchu
v interiéri

Interiér Monte Carlo

Disky z ľahkej zliatiny Proxima 6J x 16" - čierne (195/55 R16)

Výškovo nastaviteľné predné sedadlá s manuálne nastaviteľnými
bedrovými opierkami

Vyhrievanie predných sedadiel s oddelenou reguláciou

Ambietné osvetlenie prepínateľné biela/červená

Elektricky nastaviteľné a vyhrievané vonkajšie spätné zrkadlá v čiernej
farbe

Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika

Lakťová opierka vpredu

Climatronic – dvojzónová automatická klimatizácia so senzorom
vlhkosti a kombi filtrom

Elektrické ovládanie okien vpredu a vzadu

3-ramenný, multifunkčný, vyhrievaný, športový, kožený volant, červené
prešívanie, s plaketkou Monte Carlo

Funkčný paket: 4 stropné madlá (zadné s háčikmi), slnečné clony
s Make-up zrkadlom na strane vodiča a spolujazdca, schránka
na okuliare, lampičky na čítanie vpredu a vzadu

Základná výbava

Essence

Selection (navyše oproti Essence)

Monte Carlo (navyše oproti Selection)
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Doplnková výbava

Selection Plus › Disky z ľahkej zliatiny Rotare Aero 5,5J x 15" - strieborné (pneu 185/
65 R15)

› Vkladané tkané koberce vpredu a vzadu
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box
› Stredová konzola s držiakom na nápoje
› Výškovo nastaviteľné predné sedadlá s manuálne nastaviteľnými

bedrovými opierkami
› Elektrické ovládanie okien vzadu

(nie je možné s PUV/WQ3/WQ6/WQ8 a pre 1.5 TSI 110 kW)

WSA 419

Disky z ľahkej zliatiny Rotare Aero 5,5J x 15" - čierne lesklé
(cena platí iba v kombinácii s paketom WSA)

PJ3 − 116 −

Disky z ľahkej zliatiny Proxima 6J x 16" - strieborné (pneu 195/55 R16)
(cena platí iba v kombinácii s paketom WSA)

PJ4 − 483 −

Disky z ľahkej zliatiny Proxima 6J x 16" s Aero krytmi- čierne lesklé (pneu 195/55 R16)
(cena platí iba v kombinácii s paketom WSA)

PJ5 − 657 −

Disky z ľahkej zliatiny Proxima 6J x 16" s Aero krytmi - sivé (pneu 195/55 R16)
(cena platí iba v kombinácii s paketom WSA)

PJ6 − 657 −

Assisted Drive › Adaptívny tempomat do 210 km/h
› Adaptive Lane Assist - adaptívne vedenie v pruhu

(nie je možné pre 1.0 MPI 59 kW a PLC/PLG)

PUE − 424 424

Assisted Drive Plus › Navyše oproti Assited Drive:
› Side Assist
› Vnútorné spätné zrkadlo s automatickým stmavovaním
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie spätné zrkadlá

s automatickým stmievaním na strane vodiča
› Light and Rain Assist - svetelný a dažďový senzor
› Predné hmlové svetlomety s funkciou corner

(nie je možné pre 1.0 MPI 59 kW a PLC/PLG)

PUF − 1072 1027

Assisted Drive Premium › Navyše oproti Assited Drive Plus:
› Full LED predné svetlomety s LED denným svietením a LED corner

funkciou
(nie je možné pre 1.0 MPI 59 kW a PLC/PLG)

PU3 − 1670 1626

Light & View › Vnútorné spätné zrkadlo s automatickým stmavovaním
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie spätné zrkadlá

s automatickým stmievaním na strane vodiča
› Light and Rain Assist - svetelný a dažďový senzor
› Predné hmlové svetlomety s funkciou corner

PUM − 376 328

Light & View Plus › Navyše oproti Light&View:
› Full LED predné svetlomety s LED denným svietením a LED corner

funkciou

PUN − 1016 970

Safety paket › Kolenný airbag
› Bočné airbagy vzadu

PE4 478 478 478

Asistent rozjadu do kopca UG1 85 • •

Transport › Cargo Elementy
› Multifunkčná kapsa so zadným platom
› Sieťový program
› Obojstranný koberec v batožinovom priestore (guma/látka)

PUP 113 113 113

Transport s dvojitou
podlahou

› Cargo Elementy
› Multifunkčná kapsa so zadným platom
› Sieťový program
› Obojstranný koberec v batožinovom priestore (guma/látka)

(možné len s 3GD)

PUQ − 97 97

Family › Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Lakťová opierka vzadu
› Držiak na tablet

PUR − 140 140

Essence Selection Monte CarloAkčné pakety

Essence Selection Monte CarloKombinačné ceny pre akčné pakety

Essence Selection Monte CarloBezpečnosť

Essence Selection Monte CarloFunkčnosť
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Paket na zlé cesty (nie je možné s 17"/18" diskami kolies a pre motorizáciu 1.5 TSI 110kW) PK4 203 203 −

Výsuvné integrované ostrekovače svetlometov, ukazovateľ hladiny kvapaliny v nádobe
na ostrekovače

PK5 165 165 146

Príprava pre ťažné zariadenie (nie je možné s WC2) PTX 120 120 −

Ťažné zariadenie – odnímateľné (nie je možné s WC2) PTZ − 545 −

Ťažné zariadenie – odnímateľné s adaptérom (nie je možné s WC2) PTY − 585 −

Fajčiarsky paket (popolník vpredu a zapaľovač) 9JD 30 30 30

Dvojitá podlaha v batožinovom priestore (možné len s PUQ) 3GD − 153 153

Športový podvozok PSP − 148 148

Lodge › Látkové sedadlá Lodge
› Ambietné osvetlenie prepínateľné biela/červená
› Poťah prístrojovej dosky Látka Nuba Grey s prešívaním
› Chrómové orámovanie výduchov ventilácie
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› 4 LED lampičky na čítanie
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ3 − 635 −

Suite › Látkové sedadlá Lodge s prvkami Copper
› Ambietné osvetlenie prepínateľné biela/červená
› Poťah prístrojovej dosky Látka Nuba Copper s prešívaním
› Chrómové orámovanie výduchov ventilácie
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› 4 LED lampičky na čítanie
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ6 − 635 −

Dynamic › Športové látkové sedadlá
› Poťah prístrojovej dosky Látka Dynamic
› Ambietné osvetlenie prepínateľné biela/červená
› Ozdobné kryty pedálov z ušľachtilej ocele
› Vkladané tkané koberce vpredu a vzadu
› 3-ramenný športový kožený multifunkčný volant
› Chrómové orámovanie výduchov ventilácie
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ8 − 774 0

2-ramenný kožený multifunkčný volant PLB 399 • −

2-ramenný kožený multifunkčný volant s ovládaním DSG prevodovky PLC − 104 −

2-ramenný vyhrievaný kožený multifunkčný volant (možné len s PHB/PUH/PUI) PLD − 109 −

2-ramenný vyhrievaný kožený multifunkčný volant s ovládaním DSG prevodovky (možné len
s PHB/PUH/PUI)

PLE − 188 −

3-ramenný športový kožený multifunkčný volant PLF − 99 −

3-ramenný športový kožený multifunkčný volant s ovládaním DSG prevodovky PLG − 234 −

3-ramenný športový vyhrievaný kožený multifunkčný volant (možné len s PHB/PUH/PUI) PLH − 208 −

3-ramenný športový vyhrievaný kožený multifunkčný volant s ovládaním DSG prevodovky (možné
len s PHB/PUH/PUI)

PLI − 287 −

3-ramenný, vyhrievaný, multifunkčný, športový, kožený volant s pádlami pod volantom (len pre AP) PLM − − 78

Essence Selection Monte CarloFunkčnosť

Essence Selection Monte CarloVolanty / interiéry / sedadlá
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Disky z ľahkej zliatiny Rotare Aero 5,5J x 15" - strieborné (pneu 185/65 R15) PJ2 627 627 −

Disky z ľahkej zliatiny Rotare Aero 5,5J x 15" - čierne lesklé (pneu 185/65 R15) PJ3 − 745 −

Disky z ľahkej zliatiny Proxima 6J x 16" - strieborné (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ4 1112 1112 / • −

Disky z ľahkej zliatiny Proxima 6J x 16" s Aero krytmi - čierne lesklé (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ5 − 1284/ 174 −

Disky z ľahkej zliatiny Proxima 6J x 16" s Aero krytmi - sivé (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ6 − 1284 / 174 −

Disky z ľahkej zliatiny Procyon 7J x 17" - strieborné (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ7 − 1594/ 483 −

Disky z ľahkej zliatiny Procyon 7J x 17" s Aero krytmi - čierne lesklé (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ8 − 1766 / 657 −

Disky z ľahkej zliatiny Procyon 7J x 17" s Aero krytmi - sivé (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ9 − 1766 / 657 −

Disky z ľahkej zliatiny Procyon 7J x 17" - čierne lesklé (pneu 215/45 R17) PJE − − 483

Disky z ľahkej zliatiny Libra 7J x 18" - čierne (pneu 215/40 R18)
(nie je možné pre 1.0 MPI 59 kW)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJF − 2420 / 1308 1094

Rezervné koleso (neplnohodnotné) pre 15" disky + zdvihák +klúč na kolesá PJA 165 165 −

Rezervné koleso (dojazdové) pre 16", 17" a 18" disky + zdvihák +klúč na kolesá PJB 165 165 165

Comfort › Vkladané tkané koberce vpredu a vzadu
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Stredová konzola s držiakom na nápoje typu Snehuliak
› Výškovo nastaviteľné sedadlo vodiča

(nie je možné s 9JD)

PU0 213 − −

Comfort Plus › Vkladané tkané koberce vpredu a vzadu
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Stredová konzola s držiakom na nápoje typu Snehuliak
› Výškovo nastaviteľné predné sedadlá s manuálne nastaviteľnými

bedrovými opierkami
› Elektrické ovládanie okien vzadu

(nie je možné s WQ3/WQ6/WQ8)

PUV − 401 •

Park & Go › Zadná parkovacia kamera s ostrekovačom
› Drive Mode Select
› KESSY- bezkľúčové odomykanie, zamykanie a štartovanie
› Predné parkovacie senzory

(nie je možné pre 1.0 MPI 59 kW)

PUA − 666 666

Park & Go Plus › Naviac oproti Park & Go:
› Park Assist – parkovací asistent

(nie je možné pre 1.0 MPI 59 kW)

PUC − 740 740

Park & Go (so Safe
Systémom a Alarmom)

› Zadná parkovacia kamera s ostrekovačom
› Drive Mode Select
› KESSY - bezkľúčové odomykanie, zamykanie a štartovanie so Safe

Systémom
› Alarm
› Predné parkovacie senzory

(nie je možné pre 1.0 MPI 59 kW)

PUB − 833 833

Park & Go Plus (so Safe
Systémom a Alarmom)

› Naviac oproti Park & Go:
› Park Assist – parkovací asistent

(nie je možné pre 1.0 MPI 59 kW)

PUD − 880 880

Parkovacie senzory vpredu 7X2 − 351 351

Parkovacia kamera s ostrekovačom KA2 − 375 375

Essence Selection Monte CarloDisky / pneumatiky

Essence Selection Monte CarloKomfort
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Vyhrievané predné sedadlá 4A3 283 283 •

Winter Plus › Vyhrievané predné sedadlá
› Ukazovateľ stavu kvapaliny v ostrekovači
› Climatronic – dvojzónová automatická klimatizácia so senzorom

vlhkosti a kombi filtrom
› Vnútorné spätné zrkadlo s automatickým stmavovaním

(iba s PLD, PLE, PLH, PLI)

PUH − 503 •

Winter Premium › Naviac oproti Winter Plus:
› Vyhrievané čelné sklo

(iba s PLD, PLE, PLH, PLI)

PUI − 613 143

Chrome › Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika
› Podokenná chrómová lišta
› Nástupné prahové lišty na prahoch dverí

PUJ − 253 −

Tempomat s obmedzovačom rýchlosti 8T6 165 • •

Adaptive Cruise Control – adaptívny tempomat do 210 km/h (nie je možné pre 1.0 MPI 59 kW) PL2 − 313 313

Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika 4KF 165 165 •

Climatronic – dvojzónová automatická klimatizácia so senzorom vlhkosti a kombi filtrom PHB − 396 •

Operadlo predného sedadla spolujazdca sklopné do vodorovnej polohy (možné len s WQ3/WQ6) 3H2 − 99 −

Technology › 2 reprodktory vzadu
› Bezdrôtový Smartlink

WUS 314 • •

Navi paket › Škoda Navigation s 9,2" dotykovým displejom
› Virtuálny kokpit – 10" digitálny prístrojový panel s nastaviteľným

zobrazovaním údajov
› Hlasové ovládanie
› Care Connect + Infotainment online služby na 3 roky

WNA − 1293 1293

Charging › Phonebox
› 2 x USB-C vzadu
› USB-C v držiaku vnútorného spätného zrkadla

(možné iba s WQ3/WQ6/WQ8/PUV/WSA)

PU2 − 299 299

Virtuálny kokpit – 10" digitálny prístrojový panel s nastaviteľným zobrazovaním údajov 9S0 − 474 474

Sound paket › Sound Systém Škoda - Škoda Soundpaket so 6 reproduktormi
a subwoofer

› Rezervné koleso (dojazdové) pre Sound Systém
› Zdvihák +klúč na kolesá

(nie je možné s 9S0)

PJC − 674 674

Alarm PD1/PD3 261 261 261

KESSY- systém bezkľúčového odomykania, zamykania a štartovania s alarmom a systémom safe PD5 − 465 465

Modrá Energy UNI 0 0 −

Biela Candy SPE 359 359 −

Metalické farby MET 539 539 0

Oranžová Phoenix, Červená Velvet FLT 897 897 359

Color Concept Čierny -
nezahŕňa farbu vozidla

› Čierna strecha
› Čierne vonkajšie spätné zrkadlá
› Chrómované orámovanie prednej masky (iba pre Selection)
› Čierne orámovanie prednej masky (iba pre Monte Carlo)

(možné len s PJ5/PJ8)

WC1 − 243 231

Color Concept Sivý -
nezahŕňa farbu vozidla

› Sivá strecha
› Sivé vonkajšie spätné zrkadlá
› Sivé orámovanie prednej masky

(možné len s PJ6/PJ9)
(nie je možné s PTX/PTY/PTZ)

WC2 − 257 −

Predĺžená záruka na 5 rokov/100 000 km EA4 • • •

Predĺžená záruka na 5 rokov/150 000 km EA9 203 203 203

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Essence Selection Monte CarloKomfort

Essence Selection Monte CarloMultimédiá

Essence Selection Monte CarloZabezpečenie vozidla

Essence Selection Monte CarloOstatné

www.skoda-auto.sk



Ponuka farieb a diskov

Oranžová Phoenix, metalická Červená Velvet, metalická Strieborná Brilliant, metalická

Modrá Race, metalická Biela Moon, metalická Čierna Magic, metalická

Sivá Graphite, metalická Modrá Energy, uni Biela Candy, uni

Oceľové disky 15"
s krytmi Callisto

Rotare 15”
strieborné

Rotare 15”
čierne

Proxima 16”
strieborné

Proxima 16"
čierne lesklé
s aero krytmi

Proxima 16”
sivé

s aero krytmi

Proxima 16"
čierne lesklé

Procyon 17"
strieborné

Procyon 17"
čierne lesklé

Procyon 17"
čierne lesklé
s aero krytmi

Procyon 17"
sivé

s aero krytmi

Libra 18"
čierne lesklé

www.skoda-auto.sk



Servis 5 rokov / 75 000 km 769 1513

Servis 5 rokov / 100 000 km 997 2128

Servis 5 rokov / 150 000 km 1476 3383

Basic ProfessionalServisné balíčky

Poznámky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH 23%.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej možnú
kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 30.05.2025 (MR2026)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda

www.skoda-auto.sk
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